e @ .“

Oracle Fusion
Cloud
Sustainability

How do | get started with
Sustainability?

25C




Oracle Fusion Cloud Sustainability
How do | get started with Sustainability?

25C
G34563-01
Copyright © 2024, 2025, Oracle and/or its affiliates.

Author: Oracle Corporation


https://docs.oracle.com/pls/topic/lookup?ctx=en%2Flegal&id=cpyr&source=

Oracle Fusion Cloud Sustainability
How do | get started with Sustainability?

Contents

Get Help i
1 Overview 1
Overview of Oracle Fusion Cloud Sustainability
Oracle Sustainability Concepts 2
Overview of Accelerator Spreadsheets 4
2 Before You Begin 7
Implementation Overview 7
Prerequisites for Implementation 7
Enable the Sustainability Functional Area 8
Assign Security Privileges 9
3% Rapid Implementation 13
Rapid Implementation Overview 13
Import the Configuration Package 14
Load Emission Factor Mappings 14
Configure Sustainability Ledgers 15
Review and Configure the Setup 15
4 Regular Implementation 17
Plan and Prepare 17
Configure Sustainability Ledgers 18
Review and Edit Sustainability Lookups 19
Configure Sustainability Descriptive Flexfields 21
Create Activity Types 26
Set Profile Options 27
Create Global Warming Potentials 29
Configure Emission Factor Mappings 30
Configure Invoice Classification Rules 33

ORACLE



Oracle Fusion Cloud Sustainability
How do | get started with Sustainability?

Configure Search Views 41
5 Create or Import Activities 43
Create Activities 43
Generate Activities from Payables Invoices 44
Import Activities Using FBDI Templates 46
6 Review and Manage Activities 49
Review Activities 49
Manage Activities 49
"7 Manage Periods 51
Manage Periods 51
8 Troubleshooting 53
Troubleshooting 53

ORACLE



Oracle Fusion Cloud Sustainability Get Help
How do | get started with Sustainability?

Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Overview

Overview of Oracle Fusion Cloud Sustainability

Oracle Fusion Cloud Sustainability helps organizations to easily capture and manage data associated with sustainability
activities. Oracle Sustainability also helps you to consolidate and streamline sustainability data from disparate systems
and provides you with visibility and insights needed to make impactful decisions to achieve your sustainability targets.

Oracle Sustainability lets you capture and manage sustainability data that's associated with environmental, social, and
governance activities. It lets you streamline the data collection process, prove traceability to auditors, drill back from
summarized metrics into the underlying transactional data to get the context needed to drive impactful decisions, and
build sustainability awareness and measurement into your organization’s operations.

The following figure shows the flow of data through Oracle Sustainability, starting from the various data sources at the
bottom to the analytics applications at the top that can consume sustainability ledger data for reporting.
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By capturing sustainability data in Oracle Fusion enterprise applications, and providing tools to analyze this data, Oracle
Sustainability helps you streamline the data collection and analysis process.

Oracle Sustainability Concepts

Learn about the definitions that are key to performing various tasks in Oracle Fusion Cloud Sustainability.
« Activities and Activity Types
« Emission Factor Mappings
- Sustainability Ledgers

- Invoice Classification
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Activities and Activity Types

- A sustainability activity is a record of an event, action, or purchase that has sustainability impact. The impact

can be environmental, social, or related to corporate governance, or can relate to any other sustainability area
specific to your business.

- An activity type is a way of classifying a sustainability activity. Examples of emission-generating activity types

include Stationary Combustion, Mobile Combustion, and so on. Examples of activity types that do not generate
emissions include Tree Planing, Charitable Giving, and so on.

For each activity type, you can:

o Have one or more activity type attributes, which are attributes specific to an activity type that capture
data to help describe an activity of that type. For example, the Stationary Combustion activity type
typically has a Fuel Type attribute.

o Define one or more measure types. A measure type describes the quantitative data you want to capture
on an activity record. Oracle provides three predefined measure types: Quantity, Distance, and Amount.
You can define any additional measure types you need.

o For an activity type that generates emissions, you must define one or more emission types. An emission
type is a greenhouse gas or other pollutant (for example, an air pollutant) whose emissions you want to
calculate or enter.

Emission Factor Mappings

- An emission factor mapping is a record that maps an activity type and a set of attribute values to an emission

factor for a specific emission type. To calculate an activity’s emissions for a specific emission type, the emission
calculator of Oracle Sustainability finds the emission factor mappings that match the activity and the emission

type. Oracle Sustainability calculates greenhouse gas (GHG) emissions by using emission factor mappings with
the lowest rank number and Global Warming Potentials (GWPs).

An emission factor mapping ranking is a number included in an emission factor mapping record. The ranking
specifies the priority of the mapping when the emission calculator finds multiple matching emission factor
mappings for the same emission type. A lower number specifies a higher priority.

Sustainability Ledgers

A sustainability ledger is a source of truth in Oracle Sustainability for reporting. You define a sustainability
ledger by providing a unique name for the ledger, a description, an accounting calendar, and a first period.

The accounting calendar associated with the sustainability ledger is a calendar that’s defined in Oracle
Fusion Financials Cloud. The first period assigned to the ledger indicates the period from which the ledger is
operational.

You can assign one or more legal entities to a sustainability ledger, but a legal entity can be assigned to only
one sustainability ledger.

Note: A sustainability ledger is not a financial ledger and has no relation to your financial accounting
process.
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Invoice Classification

If you process Payables Invoices in your Fusion environment, Oracle Sustainability lets you automatically generate
activities and calculate emissions for each invoice distribution. This can be particularly useful for Scope 3 Category 1
(Purchased Goods and Services) activities. The following definitions are key to this task:

- An activity classification is a list of all valid combinations of activity type and activity type attributes for which
emission factor mappings exist.

- Aninvoice classification rule is a rule that specifies an outcome activity classification provided a set of
conditions are met. For example, a rule might specify that if the invoice line description contains the term Diesel
and the supplier is Green Corp., then the activity classification should be stationary combustion.Diesel. There
are two types of classification rules:

o Exclusion Rule - Specifies that any invoice distribution that meets a specific set of conditions must be
ignored and should not be considered for activity creation. These rules are executed first. Any invoice
distributions that meet the conditions of any exclusion rule are ignored, and activities aren't generated
from them.

o Assignment Rule - Specifies that any invoice distribution that meets a specific set of conditions laid
out in the rule must result in an activity that uses the activity classification specified on the rule. These
assignment rules are evaluated in the order of ranking from the highest to the lowest rank. A lower
number specifies a higher priority. If an invoice distribution doesn't meet the criteria of any assignment
rules, an activity is created with a default activity type that you specify in the profile options for Oracle
Sustainability.

Overview of Accelerator Spreadsheets

Oracle provides accelerator spreadsheets that help you to quickly prepare your data for setting up Oracle Fusion Cloud
Sustainability.

Accelerator spreadsheets are templates with prepopulated data that you can use for setting up common activity types,
attribute values, and emission factors from the United States Environmental Protection Agency (US EPA) and the
United Kingdom (UK) government. Oracle recommends that you prepare your data in these templates. You can use the
templates as is or modify, add, and delete entries to meet the requirements of your business.

Oracle recommends that you use the accelerator spreadsheets to prepare your data for all entities such as activity types,
sustainability ledgers, value sets, emission factor mappings, and so on. Ensure to read the comments in the column
header of the accelerator spreadsheet that provides important information.

The following are the accelerator spreadsheets that Oracle provides:

Note: The spreadsheets only contain sample data. Modify the data to match your business requirements.

- Sustainability Ledger Sample Values
Contains a sample sustainability ledger setup with ledger name and legal entities.
- Value Sets

Contains prepopulated value sets having reference data (for example, vehicle types, fuel types, and spend
types) aligned with the US EPA and UK government emission factor mappings.

+ Activity Types
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Contains several common activity types and the possible measure and emission types associated with each
activity type.

- Global Warming Potentials (GWPs)

Contains prepopulated GWPs for several emission types.

- Emission Factor Mappings

Contains prepopulated emission factor mappings from the US EPA and UK government. There are emission
factor mapping files for specific calendar years. The first tab in each file lists the sources of the emission
factors.

- Invoice Classification Rules

Contains sample invoice classification rules to guide your own rules setup.

- Activities

Oracle provides one spreadsheet each for most common activity types such as mobile combustion, purchased
energy, stationary combustion, and so on. These spreadsheets contain sample data that help you understand
what you can capture on an activity.

In addition, Oracle provides the following published VB Add-in for Excel spreadsheets for value sets and invoice
classification rules:

- Value Set Published: You can use this spreadsheet as an alternative to manually creating value sets in Oracle
Sustainability. It can be especially useful when you need to upload multiple values for a given value set in one
go. Note that, using this published sheet, you can add values to one value set at a time.

- Invoice Classification Rules - Published: You can use this spreadsheet as an alternative to manually creating
one invoice classification rule at a time in Oracle Sustainability. However, if you plan to create or modify rules in
bulk, then you must only use this published spreadsheet.

CAUTION: Oracle recommends that you neither create your own Visual Builder Add-in for Excel spreadsheet
for invoice classification rules nor use the REST API directly to create rules, as that can result in unintended
data corruption.

You can download these published sheets from Oracle Cloud Customer Connect. Then, copy your prepared data from
the accelerator spreadsheets to the corresponding VB Add-in for Excel spreadsheets, and then upload the data to Oracle
Sustainability.

Related Topics
« Configure Emission Factor Mappings

« Upload Changes Using Oracle Visual Builder Add-in for Excel Spreadsheets

ORACLE
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2 Before You Begin

Implementation Overview

Learn about the types of implementation available for Oracle Fusion Cloud Sustainability.
Oracle Sustainability provides two approaches for implementation - rapid implementation and regular implementation.

Rapid implementation provides organizations with a means to get familiar with Oracle Sustainability by using a sample
configuration. To perform rapid implementation, Oracle provides a configuration package containing preconfigured
setup data.

By using the preconfigured setup data, you can implement Oracle Sustainability quickly and understand its features and
capabilities. With this understanding, you can quickly update the setup created through rapid implementation to meet
your specific business needs.

On the other hand, regular implementation is elaborate and complete, involving detailed configuration procedures. In
this approach, you perform the setup configuration procedures while also configuring Oracle Sustainability as per your
business needs at each stage.

After you complete your implementation, you can create or import activities in one of the following ways:

- Create activities manually in Oracle Sustainability.
- Generate activities automatically from Payables Invoices by defining invoice classification rules.

Import large volumes of activities by using file-based data import (FBDI).

Prerequisites for Implementation

These are the tasks that you must complete before you implement Oracle Sustainability.

Ensure that the following standard Fusion setup tasks are configured within your Fusion instance:
o Legal entities

Every activity must belong to a legal entity. The activity will be posted to a sustainability ledger that's
associated with the same legal entity.

o Accounting calendar

You must associate a sustainability ledger with an accounting calendar. This determines how
sustainability periods in the sustainability ledger are structured.

o Currencies

This is required to calculate emissions using spend-based emission factors, or supplier emission
intensity.
o Inventory organizations
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If you'd like to use item carbon footprint, or emission factors specific to an inventory item, then the item
needs to be validated against an inventory organization that's designated as a validation organization.

o Units of measure (UOMs)

This is required to calculate emissions using quantity-based emission factors such as quantity of fuel,
electricity units consumed, or number of units of an item procured.

- Create and configure any additional setup entities that your business requires. For example, if there's a UOM
that you plan to use in emission factor mappings or activities, but that isn't currently defined in the existing
Manage Units of Measure setup task, then define the UOMs you need. Ensure that intraclass UOM conversion
factors are set up for any newly added UOMs.

If you plan to reference Suppliers and Items in emission factor mappings or sustainability activities, then ensure
that they're already created in your Fusion instance.

If you plan to use interclass UOM conversion, then it must be configured on the inventory item that will be
referenced on the emission factor mapping and activities.

If you want to use accelerator spreadsheets for planning your data, then download the Accelerator Spreadsheet
Templates.zip file from Oracle Cloud Customer Connect.

Enable the Sustainability Functional Area

You can enable the Sustainability functional area under your respective offering by using the Opt In page of your
application.
Oracle Sustainability is available under the following offerings:

Manufacturing and Supply Chain Materials Management

Procurement

Product Management

Before you start

To perform this procedure, you must be assigned a role that includes the Configure Oracle Fusion Applications Offering
(ASM_CONFIGURE_OFFERING_PRIV) privilege.

Here's what to do

1. Click Navigator > My Enterprise > Offerings.

2. On the Offerings page, select your offering (for example Procurement), and then click Opt In Features.
3. On the Opt In page, search for Sustainability, and then select the corresponding Enable checkbox.

4. Click Done.

ORACLE
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Assign Security Privileges

Your company's security administrator who is responsible for granting roles and privileges to Oracle Fusion Cloud
Sustainability users must perform these tasks.

- Identify Users and Assign Job Roles
Create Data Security Policy For Managing Items and Item Class

Create Data Security Policy For Viewing Invoices and Accessing Invoice List of Values

Related Topics
« Overview of Security Console

|dentify Users and Assign Job Roles

You must identify and assign job roles to all users who will perform various tasks in Oracle Fusion Cloud Sustainability.
Oracle Sustainability has the following predefined roles:

- Sustainability Application Administrator: Responsible for setting up and configuring Oracle Sustainability to
meet the needs of the business.

- Sustainability Analyst: Responsible for creating, managing, and posting activity records, resulting in one or
more sustainability ledgers that can serve as data sources for analysis and reporting.

- Sustainability Controller: Responsible for reviewing sustainability analytics to ensure progress is in line with
the company's sustainability goals.

- Sustainability Integration Specialist: Responsible for planning, coordinating, and supervising all activities
related to the integration of sustainability information systems.

The complete details about these predefined roles, the role hierarchy, duties, and privileges can be found in any of the
following security reference guides:

- Security Reference for Manufacturing and Supply Chain Materials Management
- Security Reference for Procurement

- Security Reference for Product Management

As the security administrator, perform the following tasks:

1. Create your own roles by making a copy of all the predefined roles in Oracle Sustainability.

2. Assign these roles to users identified for carrying out various tasks (such as setup tasks, creating and managing
sustainability activities, and so on) in Oracle Sustainability.

3. Ensure that all users inherit the Employee abstract role and users that perform setup tasks have the
Application Administrator job role.

Note: If any of the predefined roles don't appear in the security console, then run the Retrieve Latest LDAP Changes
and Import User and Role Application Security Data jobs.

ORACLE
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Related Topics
« Retrieve Latest LDAP Changes

« Schedule the Import User and Role Application Security Data Process
- Role Copying or Editing

Create Data Security Policy For Managing Items and Item Class

To calculate emissions for a particular item (for example, an item for carbon footprint), sustainability analysts

must specify the item while creating activities or entering emission factor mappings. To enable this, a role that
includes the Manage Sustainability Activity (SUS_MANAGE_ACTIVITIES_PRIV) and Manage Emission Factor
(SUS_MANAGE_EMISSION_FACTORS_PRIV) privileges must be granted data access to the appropriate item classes.

Before you start

To perform this procedure, you must be assigned a role that includes the Manage Item Class
(EGP_MANAGE_ITEM_CLASS_PRIV) privilege.

Here's what to do

1. Inthe Setup and Maintenance work area, use the Manage Item Classes task:
o Offering: Product Management

o Functional Area: Items

2. On the Manage Item Classes page, search for and select the item class name for which you want to grant access. The
Edit Item Class page is displayed.

3. On the Security tab, click the Add Row icon to create the data policy. A new row is added. You can create data policies
either for groups (jobs or duty roles) or users.

4. If you want to grant access to all users who are assigned a role that has the privileges of the predefined Sustainability
Analyst role, then:

a. From the Principal column, select Group.
b. Inthe Name column, search for and select, or enter the job role name.

c. Inthe Organization column, search for and select, or enter the organization name that will be used to
validate the item. For example, Vision Corporation.

Note: The organization name that you specify here must also be specified as the value of the
ORA_SUS_ITEM_VALIDATION_ORG_CODE profile option.

5. If you want to grant access to a specific user, then:
a. From the Principal column, select Person.
b. Inthe Name column, search for and select, or enter the name of the user. For example, John Doe.

c. Inthe Organization column, search for and select, or enter the organization name that will be used to
validate the item. For example, Vision Corporation.

Note: The organization name that you specify here must also be specified as the value of the
ORA_SUS_ITEM_VALIDATION_ORG_CODE profile option.

10
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6. Define the actions that the group or user can perform by adding actions as follows:
a. Inthe Actions section, from the Actions menu, select Select and Add. The Select and Add: Actions dialog
box is displayed.
b. Inthe Actions field, enter View Item Basic, and then click Search.
c. From the search results, select View Item Basic and then click OK. The action is added to the Actions table.
7. Click Save and Close to close the Edit ltem Class page.
8. On the Manage Item Class page, click Done.

Create Data Security Policy For Viewing Invoices and Accessing
Invoice List of Values

If you want to automatically generate activities from invoices or want to manually link sustainability activities to
payables invoices, then you must grant the invoice data access to a user who is responsible for creating activities in
Oracle Fusion Cloud Sustainability.

This access lets the user associate the activity with an invoice or drill into an invoice from an activity. This
is the user who is assigned a role that includes the Generate Sustainability Activity from Payables Invoice
(SUS_GENERATE_ACTIVITIES_FROM_INVOICES) privilege.

Before you start
To perform this procedure, you must be assigned a role that is based on the IT Security Manager job role.

Here's what to do

1. Navigate to Tools > Security Console.
2. Onthe Roles page, click Create Role to create your own job role.

3. On the Create Role page, in the Role Name field, enter a role name such as Invoice Data Access. Specify values for
the rest of the fields on the page such as Role Code and Role Category.

4. Navigate to the Data Security Policies train stop.
On the Data Security Policies page, click Create Data Security Policy.
6. In the Create Data Security Policy dialog box:

o Enter a name for the policy. For example, Grant on Invoices.

v

o Inthe Start Data field, a date is automatically assigned. Change this date if required.
o Inthe Data Resource field, search for and select Business Unit (FUN_ALL_BUSINESS_UNITS_V). This is
the data resource for which you're defining the policy.
o From the Data Set drop-down list, select Select by instance set.
o From the Condition Name drop-down list, select Access the business units for which the user is
explicitly authorized.
o From the Actions drop-down list, select Manage Payables Invoice.
7. Click OK.
8. Navigate to the Summary train stop.
9. Click Save and Close.

10.1n the Setup and Maintenance work area, go to the Manage Business Unit Data Access for Users or Manage Data
Access for Users task in the Users and Security functional area.

n
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11. On the Manage Data Access for Users page, ensure that the value of the Security Context drop-down list is set to
Business Unit.

12. In the Search Results section, click the Create icon.
13. In the Create Data Access for Users dialog box:

an oo

e.

From the User Name drop-down list, select the user to whom you need to grant access.
From the Role drop-down list, select Invoice Data Access.

From the Security Context drop-down list, select Business unit.

From the Security Context Value drop-down list, select your business unit.

Click Save and Close.

14.0n the Manage Data Access for Users page, verify that the user access is granted, and then click Done.

15. Assign the job role that you created (for example, Invoice Data Access) to the user who is assigned a role that has the
privileges of the predefined Sustainability Analyst role to create activities.

12
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5 Rapid Implementation

Rapid Implementation Overview

Oracle provides a configuration package with sample data for performing a rapid implementation. This package
is intended for use only in a test environment to gain a quick start, enabling you to explore Oracle Fusion Cloud
Sustainability and learn about its functionality hands-on.

The rapid implementation package is a collection of setup data provided by Oracle. You can readily import this package
into your Fusion instance by using the Import option available in the Setup and Maintenance work area.

Note: This package will work only if you've enabled the Procurement offering.

You can use the package in the following scenarios:
- You want to explore Oracle Sustainability and learn about its functionality hands-on.

- You want to adopt a ready-to-use configuration and build on it to accommodate your requirements.

After you download and import the configuration package into your environment, data for the following setup tasks is
automatically created in Oracle Sustainability:

Manage Sustainability Value Sets
Manage Sustainability Descriptive Flexfields
Manage Activity Types

Manage Global Warming Potentials

In addition, you must do the following:

Load emission factor mappings: Oracle provides a data sheet for uploading emission factor mappings. This
data sheet contains only a small subset of the emission factors listed in the accelerator spreadsheet. Oracle
recommends that you use the data sheet only for testing purposes as it only contains sample data.

- Create sustainability ledgers: You can do this by creating ledgers directly in Oracle Sustainability.

- Set up the profile values for the CO2e Reporting UOM and Currency Conversion Rate Type profile options.

Next, verify the setup data in your test environment. With some additional steps and modifications that meet your
business needs, you can promote the rapid implementation package (excluding the emission factor mapping data
sheet) to get started with production configuration.

CAUTION: When you create and post activities by using the preconfigured setup data, you will not be able to
completely remove or modify the underlying setup data from your instance. Therefore, Oracle recommends that
before you create and post activities, plan and only retain data that aligns with your implementation and delete the
rest. Otherwise, prepare to refresh your test instance and perform a regular implementation as described in this
playbook.

13
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Import the Configuration Package

Import the rapid implementation configuration package into your environment by using the Import option in the Setup
and Maintenance work area.

Before you start

Download the rapid implementation package (Rapid Implementation Package.zip) from Oracle Cloud Customer
Connect.

Ensure that you've enabled the Sustainability functional area for your offering.

Ensure that you're assigned a role that has all the privileges of the predefined Sustainability Application
Administrator role and the Export Import Functional Setups User abstract role.

To import the rapid implementation package:

1. Inthe Setup and Maintenance work area for Procurement offering, select Import from the Actions menu
corresponding to the Sustainability functional area, and then click Create New.

2. Inthe Warning dialog box that's displayed, click Yes.

3. Onthe Import Offering Setup Data page, click Choose File and select the previously downloaded rapid
implementation package.

4. Expand the Import Options section, select or deselect any check boxes if needed and then click Submit.

5. Inthe Confirmation dialog box, click OK.

6. Monitor the import process by clicking Actions > Import > View all corresponding to the Sustainability
functional area.

7. Monitor the import process until it completes successfully.

Data for setup tasks including value sets, descriptive flexfields, activity types, and global warming potentials are
created and available in Oracle Sustainability.

Related Topics

Load Emission Factor Mappings

Oracle provides a data sheet for emission factor mappings with prepopulated emission factors corresponding to the
activity types in the rapid implementation configuration package. These prepopulated emission factors are only a small
subset of the ones available in the accelerator spreadsheet for emission factor mappings.

Download the data sheet (Emission Factor Mappings Data Sheet.xlsx) from Oracle Cloud Customer Connect.
Generate an Oracle Visual Builder Add-in for Excel spreadsheet for emission factor mappings.
Copy data from the data sheet into the VB Add-in spreadsheet.

In the VB Add-in spreadsheet, update the UOMs and currencies to match the ones configured in your Fusion
instance.

In the Ranking column, assign relative ranking to the emission factors that you want to use.
Upload the emission factors data to Oracle Sustainability.

A WN S

o w
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Related Topics
« Generate Emission Factor Mappings Spreadsheet

Configure Sustainability Ledgers

You must configure sustainability ledgers by creating a ledger, associating an accounting calendar, assigning one or
more legal entities, and retrieving periods.

Related Topics
- Create Sustainability Ledgers

« Retrieve Future Periods

Review and Configure the Setup

Review all the setup data that's imported from the rapid implementation package.

Before you start

Ensure that you're assigned a role that has all the privileges of the predefined Sustainability Application Administrator
role.

1. Inthe Setup and Maintenance work area, go to each of the following tasks in the Sustainability functional area
to review the corresponding data that was imported and modify them as needed:

a. Manage Activity Types

Delete any activity types that you don't intend to use.
b. Manage Sustainability Descriptive Flexfields

Disable context-sensitive segments and delete contexts corresponding to the activity types that you
deleted in the preceding step.

c. Manage Sustainability Value Sets

Disable any value sets or their values that you don't intend to use.
d. Manage Global Warming Potentials

Delete any global warming potentials that you don't intend to use.

2. Inthe Sustainability Measure Types and Sustainability Emission Types lookups, disable any measure types or
emission types, respectively, that you don't intend to use.

3. If the preconfigured setup data does not meet your organization's business needs, then make adjustments as
needed directly in the application.

4. Set values for the CO,e Reporting UOM (ORA_SUS_CO2E_REPORTING_UOM) and Currency Conversion Rate
Type (ORA_SUS_CUR_CONVERSION_RATE_TYPE) profile options.

5. Configure the search index to enable the activity type attributes to be visible in the search results on the
Sustainability Activities page.
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6. Create a few activities in your environment. While doing so, ensure that the attributes used while creating
activities match the attributes on the emission factors provided in the data sheet so that calculation of
emissions can happen.

7. Conduct thorough testing to ensure that the setup functions correctly in your business environment. For
example, you can calculate emissions, validate and post your activities to a sustainability ledger, and close a
period.

CAUTION: Before you create and post activities, review all preconfigured setup data and delete any data that doesn't
meet your business needs. After posting activities, if you don't intend to continue with the setup any more, then you'll
not be able to delete it from your environment.

Related Topics
« Set Profile Options

« Configure Search Indexes
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4 Regular Implementation

Plan and Prepare

Oracle recommends that you prepare for regular implementation by planning for these tasks.

1. Prepare your activity types and related data as follows:

a.

b.

Review the Activity Types accelerator spreadsheet and remove, update, or add any activity types and
associated measure and emission types that are specific to your implementation.

Review the Value Sets accelerator spreadsheet containing the values that the activity type attributes
can have and remove any unwanted entries from the spreadsheet. In addition, add or update value sets
and values for any new or updated activity types and type attributes that you created or modified in the
previous step.

Note:
- Load only those entries that you intend to use to keep the data to a minimum.

- Activity type attributes are configured using the Manage Descriptive Flexfield setup
task during implementation.

2. Identify and, if necessary, configure the UOMs that will be used for sustainability activities and emission factors
as follows:

a.

Ensure that you've configured any required intraclass UOM conversions.

For example, if you have activities that measure fuel in galions, but your emission factors have 1iters
in the denominator, then ensure that you have configured a conversion factor from gaillons to 1iters in
your Fusion instance.

Ensure that you've configured any required interclass UOM conversions for inventory items.

For example, if you have an emission factor that is based on the quantity of an item (for example, a
product carbon footprint), and you have interclass UOM conversions configured on the item, then the
calculator will perform a configured interclass UOM conversion to align the UOM of the measure on the
activity with the denominator UOM of the emission factor.

To avoid rounding issues in emission calculations, set up the UOM conversion factors in Inventory with a
high degree of decimal precision as emission factors might have many decimal digits. The calculator uses
the following formula for emission calculations:

COze emission = emission * GWP * UOM conversion factor rounded to precision as set up in the
Quantity Decimal Precision (INV_QUANTITY DECIMAL PRECISION) profile option

You can set a value for the INV_QUANTITY_DECIMAL_PRECISION profile option by searching for and
selecting the Manage Administrator Profile Values task in the Setup and Maintenance work area.

3. Review the Global Warming Potentials accelerator spreadsheet and make any changes if required.
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4. Inthe Emission Factor Mappings accelerator spreadsheet:

o Configure emission factors. The calculator will perform any interclass and intraclass UOM conversions,
if required, assuming the required conversion factors are set up in your Fusion instance. Note that
interclass conversion will be performed only if the activity references an item.

o Update the UOM and Currency values to match with the ones configured in your Fusion instance.

o Oracle doesn't provide emission factors for CO,e of component gases such as CH4 and N,O. To model
the emission factors for CO,e of component gases from sources like the UK government, create a new
emission type to represent the CO,e of the component gas (for example, CO,e of Methane, CO,e of
Nitrous Oxide) in the Sustainability Emission Types (ORA_SUS_EMISSION_TYPES) lookup and set the
corresponding global warming potential (GWP) value to 1. Then, ensure that you associate the newly
created emission types with the respective activity types. You can now upload CO,e emission factor
mappings for these emission types.

5. Oracle recommends that you read the United States Environmental Protection Agency (US EPA) or UK
government guidance on reporting Biogenic CO, emissions. If you want to align with the guidance by omitting
Biogenic CO, from any of the emission scopes, then add Biogenic CO, as an emission type for any activity type
where you're going to burn biomass fuels. Then, change the emission type in the emission factor mappings
spreadsheet for those fuels from CO, to Biogenic CO,. The calculator omits Biogenic CO, from total COe. This
behavior requires that you don't configure a GWP for Biogenic CO,. Note that Oracle doesn'’t include one in the
accelerator spreadsheet for GWPs.

Configure Sustainability Ledgers

Create and configure sustainability ledgers for reporting sustainability data.

You must first setup the sustainability ledger and then retrieve future periods to start creating activity records for the
ledger as follows:

1. Create Sustainability Ledgers
2. Retrieve Future Periods

Create Sustainability Ledgers
You can create sustainability ledgers by using the Manage Sustainability Ledgers task.

Before you start
To perform this procedure, you must be assigned a role to access the Manage Sustainability Ledgers task.

1. In the Setup and Maintenance work area, go to the Manage Sustainability Ledgers task:

o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement

o Functional Area: Sustainability

2. On the Sustainability Ledgers page, click Create Sustainability Ledger.

3. Inthe New ledger drawer, enter the ledger name and select the accounting calendar. Optionally, enter a
description.

4. From the First Period drop-down list, select the first period.
5. From the Legal Entities drop-down list, select one or more legal entities to assign to the ledger.
6. Click Create.
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Note:
If your legal entity names aren't unique, then on the Sustainability Activities page, you'll experience issues
when selecting a legal entity name that isn't unique.

Oracle General Ledger and Sustainability can share the same accounting calendar, but the period close process
happens independently. You can close your Financials period, and keep your Sustainability period open, and
then close it at a later date.

Use the first period to signify the period from which you'll start using Oracle Sustainability to record your
sustainability activities. For example, even if you're in the middle of a fiscal or calendar year, you might want to
start recording back-dated activities from the beginning of the year to simplify your annual reporting.

Retrieve Future Periods

After the ledger is configured, you can retrieve future periods from the accounting calendar starting from the first
period assigned to the Sustainability Ledger. These are your sustainability periods, and you can manage their statuses
within Oracle Fusion Cloud Sustainability.

Before you start

To perform this procedure, you must be assigned a role that has all the privileges of the predefined Sustainability
Controller role.

You retrieve future periods from the Periods tab on the Sustainability Activities page as follows:

Click Navigator > Sustainability > Sustainability Activities.

Click the Periods tab.

On the Sustainability Periods page, select your sustainability ledger from which you must retrieve periods.
Click Retrieve Future Periods.

PUWUNA

All periods starting from the first period specified on the ledger with a default status of Open are retrieved and
displayed in the Periods section.

The Periods section displays all the periods retrieved from the accounting calendar with its details. When more periods
are added to the accounting calendar, you can use the Periods page again to retrieve the additional periods by clicking
Retrieve Future Periods.

Review and Edit Sustainability Lookups

Use the Manage Sustainability Lookups task to add or edit values of standard lookups that are available in Oracle
Fusion Cloud Sustainability. Editing these lookups is optional.

Oracle Sustainability comes with a set of predefined lookups. Depending on the configuration level of lookups, you can
edit or remove existing lookups, or add new ones. Oracle recommends that you review the lookups and edit them if
required. Otherwise, skip this topic.
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Lookup Type

ORA_SUS_ACT_PROCESS_MODE

ORA_SUS_ACT_STATUS

ORA_SUS_CAL_MODE

ORA_SUS_DATA_QUALITY

ORA_SUS_EMISSION_TYPES

ORA_SUS_ENTRY_TYPE

ORA_SUS_MEASURE_TYPES

ORA_SUS_MSG_LEVEL_CODE

ORA_SUS_MSG_SUM_CODE

ORA_SUS_PERIOD_STATUSES

ORA_SUS_SCOPES

ORA_SUS_SCOPE_CATEGORIES

ORA_SUS_SOURCE_TYPE

ORACLE

Meaning

Modes for Process Sustainability
Activities Scheduled Process

Sustainability Activity Status

Calculation Mode

Data Quality Indicator

Sustainability Emission Types

Entry Type

Sustainability Measure Types

Validation Message Level

Validation Message Summary

Sustainability Period Status

Scope

Scope Category

Sustainability Activity Source

Description

Processing modes for the Process
Sustainability Activities scheduled
process. Values are Post to ledger
and Validate.

Status of the activity record. Values
are Draft, Posted, and Canceled.

Calculation mode. Values are Using
matched factors, Manual entry

of factors, and Manual entry of
emissions.

The accuracy of an activity's
measures or the emission

factors used to calculate
emissions. Predefined values

are High confidence, Moderate
confidence, and Low confidence.

Greenhouse gases and other
substances such as air pollutants
that are emitted by activities

such as fuel combustion. Several
predefined emission types such
as Carbon dioxide, Methane, and
Nitrous oxide.

Type of entry for the record. Values
are Standard and Adjustment.

Measure types associated with
an activity. Predefined values are
Quantity, Distance, and Amount.

Level of severity for a validation
message. For example, the
message could convey an error, a
warning, or information.

Summary of the validation
message.

Statuses of sustainability Periods.
For example, Open or Closed.

Emission scopes defined by the
Greenhouse Gas Protocol. Values
are Scope 1, Scope 2 location-
based, Scope 2 market-based,
and Scope 3.

Category under which scope

3 emissions are reported. The

15 categories defined by the
Greenhouse Gas Protocol are
provided - for example, Purchased
goods and services and Waste
generated in operations.

Source of the activity record.
Predefined values are Manual

Chapter 4
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Lookup Configuration Level

System

System

System

User

User

System

User

System

System

System

System

System

Extension
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Lookup Type Meaning Description Lookup Configuration Level

entry, External, Payable Invoice,
and File-based data import.

Before you start
To perform this procedure, you must be assigned a role to access the Manage Sustainability Lookups task.

To review and edit lookups:

1. Inthe Setup and Maintenance work area, go to the Manage Sustainability Lookups task:

o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement

o Functional Area: Sustainability

2. Onthe Manage Sustainability Lookups page, click Search.

All the standard lookups that come predefined with Oracle Sustainability are displayed.
Examine the search results to review the lookups.

4. Select the lookup type you want to review or edit. The corresponding lookup codes are displayed in the section
following the search results.

5. (Optional) Edit the lookup as desired, and then click Save and Close.

w

Tip: If you plan to use invoice classification, then in the Sustainability Measure Types lookup, don’t disable or change
the start or end dates for the “Amount” and “Quantity” measure types.

Configure Sustainability Descriptive Flexfields

There are two descriptive flexfields that are associated with the setup for Oracle Fusion Cloud Sustainability.

- Activity: This descriptive flexfield lets you extend the data attributes that you want to capture on activities.
For example, you can add an Activity descriptive flexfield to capture the facility associated with an activity.
Configuring the Activity descriptive flexfield is optional.

Emission Factor Map: To model an activity type in Oracle Sustainability, you must configure the activity type
as a descriptive flexfield context and define the associated activity type attributes as its context-sensitive
segments. For each attribute, you also need to define and populate the set of valid values.

Configuring the Emission Factor Map descriptive flexfield is required.

Configure Activity Descriptive Flexfields

Configure the Activity descriptive flexfield if you want to add additional attributes for capturing activity data.

To configure the Activity descriptive flexfield, see Overview of Descriptive Flexfields.

21
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa25c&id=s20030935

Oracle Fusion Cloud Sustainability Chapter 4
How do | get started with Sustainability? Regular Implementation

Configure the Emission Factor Map Descriptive Flexfields

To model activity types in Oracle Fusion Cloud Sustainability, you must configure the Emission Factor Map descriptive
flexfield.

For each activity type listed in the Activity Types accelerator spreadsheet, create a descriptive flexfield context. And
for each of these activity types, identify the corresponding activity type attributes (as listed in the following table) and
create them as context-sensitive segments. Then, create and populate value sets for these context-sensitive segments.

The following table lists the most common activity types and possible attributes that you can configure using
descriptive flexfields. All these activity types and corresponding attributes are included in the accelerator spreadsheets
as well.

Activity Types and its Attributes

Use Case Activity Type Activity Type Attributes

Capture fuel consumption data and calculate Stationary combustion Fuel Type
Scope 1 stationary combustion emissions.

Capture fuel or energy consumption and Mobile combustion - Energy Source
distance traveled to calculate Scope 1 mobile

combustion emissions. Vehicle Type

Percent Laden

Capture energy consumption and calculate Purchased Energy - Grid Region
Scope 2 emissions.

Energy Type
Capture data on purchases of goods and Purchased Goods and Services Spend Type
services.
Capture water consumption. Water Withdrawal Water Source Type
Capture waste generated Waste Generated in Operations - Waste Type

Waste Disposal Method
Handling Method

For example, configure the Stationary Combustion activity type as a context for the Emission Factor Map descriptive
flexfield. Then, define Fuel Type as a context-sensitive segment of Stationary Combustion. In addition, create a value set
for Fuel Type and populate fuel type values. The following is the sequence of steps for configuring the Emission Factor
Map descriptive flexfield:

1. Create and Populate Sustainability Value Sets

For each attribute of the activity type, create a value set and populate its value.
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2. Create Contexts and Context-Sensitive Segments

Create the activity type as the context and its attributes as context-sensitive segments.
3. Deploy the Descriptive Flexfield

Deploy the descriptive flexfield to view the changes.
4. Configure Search Indexes

Configure the search index to enable the activity type attributes to be displayed in search results.

Create and Populate Sustainability Value Sets
For each attribute of an activity type, you must create a value set and then populate its values.

I Note: To perform this procedure, you must be assigned a role to access the Manage Sustainability Value Sets task.

1. Inthe Setup and Maintenance work area, go to the Manage Sustainability Value Sets task:

o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement

o Functional Area: Sustainability

2. Onthe Manage Sustainability Value Sets page, click the plus icon to create a value set.

3. Onthe Create Value Set page, enter the required details. The following steps provide sample values for creating
a value set for the Fuel Type attribute:

a. Enter a value set code. For example, FUEL_TYPE.

b. Optionally, enter a description.

c. Inthe Module field, enter Environmental Activities Management.
d. From the Validation Type drop-down list, select Independent.

Use only the validation types Table or Independent. If you select Independent, then ensure to populate
the acceptable values in the Manage Values page.

e. From the Value Data Type drop-down list, select Character.
f. Inthe Definition section, from the Value Subtype drop-down list, select Text.
g. Inthe Maximum Length field, enter 150.

Click Save.

On the Create Value Set page, click Manage Values.

On the Manage Values page, click the plus icon to create a value.

In the newly added row, enter the desired values. If a value exceeds the 150-character limit, then capture the
extra information in the Description field. Leave the Description field blank unless it differs from the value.

8. Repeat Steps 6 and 7 to add more values. For example, for the Fuel Type value set, you can enter the values
Gasoline, Crude Oil, and Diesel.

9. Click Save and Close twice to save the values and its value set.

No Uk

Tip:
- To create and populate value sets in bulk, extract and use the published template for value sets (Value Set-
Published.xIsx) available on Oracle Cloud Customer Connect.

Before using this spreadsheet, download and install Oracle Visual Builder Add-in for Excel from here: https://
www.oracle.com/downloads/cloud/visual-builder-addin-downloads.html.
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Create Contexts and Context-Sensitive Segments

Create the activity type (for example, Stationary Combustion) as the context for the Emission Factor Map descriptive
Flexfield. Create the attributes (for example, Fuel Type) of the activity type as the context-sensitive segment.

Before you start
To perform this procedure, you must be assigned a role to access the Manage Sustainability Descriptive Flexfields task.

1.

OygouUhuN

1.

In the Setup and Maintenance work area, go to the Manage Sustainability Descriptive Flexfields task:
o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement
o Functional Area: Sustainability

Click the Manage Sustainability Descriptive Flexfields task.
On the Manage Sustainability Descriptive Flexfields page, click Search.
From the search results, select the row with Emission Factor Map, and then click the Edit icon.
On the Edit Descriptive Flexfield: Emission Factor Map page, in the Context Segment section, select Bl Enabled.
Click Manage Contexts.
On the Manage Contexts page, click the Create icon.
On the Create Context page, enter the required details to create the activity type as a context. The following
steps provide sample values for creating a context for the Stationary Combustion activity type:
a. Inthe Display Name field, enter the name of the activity type. For example, Stationary Combustion. The
Context Code and API name fields are automatically populated.

Ensure that the display name is less than or equal to 30 characters, including spaces. The context code,
which is generated automatically based on the display name, must not exceed 30 characters to avoid
problems later if you plan to upload data using File-Based Data Import (FBDI) or use invoice classification.
After the context code is generated, you can't update it, but you can update the display name.
b. Ensure that the Enabled checkbox is selected.

Click Save.

In the Context Sensitive Segments section, click the Create icon to add the attribute of the activity type as a

context-sensitive segment.

On the Create Segment page, enter the required details to create the attribute as a context-sensitive attribute.

The following steps provide sample values for creating a context-sensitive segment for the Fuel Type attribute

of the Stationary Combustion context value:

Note: If you're using a context that is provided in the Emission Factor Mapping accelerator spreadsheet

and has more than one context-sensitive segment, then define the context-sensitive segments in the same
sequence as it appears in the Emission Factor Mapping accelerator spreadsheet. This will ease the process of
copying data into Oracle Visual Builder Add-in for Excel spreadsheets later.

a. Inthe Name field, enter the name of the attribute (for example Fuel Type). The Code and APl Name
fields are automatically populated.
Ensure that the name is less than or equal to 30 characters, including spaces. The Code, which is
generated automatically based on the name, must not exceed 30 characters to avoid problems later if
you plan to upload data using File-Based Data Import (FBDI) or use invoice classification. After the code
is generated, you can't update it, but you can update the display name.

Note: Ensure that the value in the Name and Code fields are unique across all activity type attributes,
across all contexts.

b. Inthe Column Assignment section, from the Data Type drop-down list, select Character.
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c. The Table Column is automatically populated with the next available internal table column, for example,
EFM_ATTRIBUTE1, EFM_ATTRIBUTEZ, and so on. Don'’t change this value.

d. Inthe Validation section, from the Value Set drop-down list, select the value set that was created in one
of the earlier steps. For example, FUEL_TYPE.

e. Inthe Display Properties section, the values for the Prompt and Display Type fields are autopopulated.

f. In the Business Intelligence section, select Bl Enabled.

g. Click Save and then Save and Close.

The context-sensitive segment and the context are saved.
12. (Optional) Repeat Steps 10 and 11to add more attributes as context-sensitive segments.
13. Click Save and Close.
14. Repeat steps 7 through 13 to add more contexts and context-sensitive segments.

Deploy the Descriptive Flexfield

After creating contexts and context-sensitive segments, you must deploy the changes. After you deploy the Emission
Factor Map descriptive flexfield, you can view the changes in the Oracle Sustainability application.

To deploy the descriptive flexfield:

1. Onthe Manage Sustainability Descriptive Flexfields page, click Search.
From the search results, select the row with Emission Factor Map, and then click the Deploy Flexfield.
The deployment progress is displayed.

3. Inthe EMISSION_FACTOR_MAP Confirmation dialog box, when the deployment completes, click OK.
The Deployment Status column for this descriptive flexfield displays a green check mark.

4. Click Done.

Configure Search Indexes

After deploying the descriptive flexfield, you must update the search index to enable the activity type attributes to be
visible in the search results on the Sustainability Activities and Emission Factor Mappings page.

Before you start

To perform this procedure, you must be assigned a role that includes the Grant Search Framework Manager Permissions
(FND_SEARCH_FWK_MGR_PRIV) privilege.

To update the search index, perform the following steps on each instance where you plan to use Oracle Sustainability:

1. In the Setup and Maintenance work area, go to the Manage Search Indexes task:
o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement
o Functional Area: Application Extensions

2. Onthe Manage Search Index page, if you see the "No index" message, then wait for a couple of minutes for the
indexes to load.

3. Search for fa-prc.

4. From the search results, scroll down and locate the fa-prc-sus-activities index, and then click the Configure
icon against it.

5. On the Edit Index Activities page, scroll to and expand EmissionFactorMapDFF.

6. Expand each updated descriptive flexfield context. Then, expand each context-sensitive segment, and select
the Value and Description check boxes.

7. Click Save. Then click Cancel to go back to the Manage Search Indexes page.
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8. Refresh the Manage Search Indexes page. When the indexes are listed, search for fa-prc again. From the search
results, scroll down and locate the fa-prc-sus-activities index.
9. Click Publish for the fa-prc-sus-activities index to publish the changes.

A message confirming that a background indexing process has been submitted is displayed. After the process
is completed, the values of the updated attributes will be visible in the Activity Type Attributes column in the
Sustainability Activities page.

10. Repeat Steps 4 through 10 to update the search index for the Emission Factor Mappings page. While doing so,
ensure to replace all instances of "fa-prc-sus-activities" with fa-prc-sus-efmaps.

Tip: If the Publish button is not enabled, then depending on whether you are updating the search index for the
Sustainability Activities page or Emission Factor Mappings page, run the “ESS job to create index definition and
perform initial ingest to OSCS” scheduled process with the Index Name to Reingest parameter set to fa-prc-sus-
activities or fa-prc-sus-efmaps, respectively. Then, try publishing the index.

Create Activity Types

After you've configured the Emission Factor Map descriptive flexfields, you must define the measure types and
emission types that should be associated with the activity type.

Before you start
To perform this procedure, you must be assigned a role to access the Manage Activity Types task.
You can create an activity type as follows:

1. Inthe Setup and Maintenance work area, go to the Manage Activity Types task:
o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement
o Functional Area: Sustainability

2. On the Activity Types page, click Add Activity Type.

3. Inthe New activity type drawer, from the Activity Type drop-down list, select the activity type. The context
values that you had created in Create Contexts and Context-Sensitive Segments will appear as available activity
types for measure type and emission type association. The Description field is automatically populated based
on the value that you specified while configuring the context in the Emission Factor Map descriptive flexfield.
Start date if not changed, defaults to the system date.

4. From the Scope drop-down list, select a scope for the activity type. If you select Scope 3, then you must specify
the scope category.

5. Select one or more measure types and emission types from the respective drop-down lists.

6. Click Create. Or, click Create and Add Another to create more than one activity type.

The activity type is created.

Tip: To stop using an activity type that has already been used in activities, set its end date to the last date on which
it should be active. Don't disable the corresponding descriptive flexfield context unless the activity type was created
incorrectly or hasn't been used.
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Set Profile Options

Set profile options to configure and control aspects of the functionality of Oracle Fusion Cloud Sustainability.

The following table lists the profile options for Oracle Sustainability for which you might want to set values.

Oracle Sustainability Profile Options

Profile Option Code

ORA_SUS_ITEM_
VALIDATION_ORG

ORA_SUS_ITEM_
VALIDATION_ORG_CODE

ORA_SUS_CO2E_
REPORTING_UOM

ORA_SUS_CONDENSED_
DECIMAL_PRECISION

ORACLE

Profile Display Name

Obsolete:ltem Master
Validation Organization

Item Validation
Organization

CO,e Reporting UOM

Condensed Decimal
Precision

Description

Obsolete. Use ORA_SUS_
ITEM_VALIDATION_ORG_
CODE profile instead

Specify the item's master
validation organization.

Specify the reporting unit
of measurement for COe.

Controls the decimal
display of attributes that
require a relatively lower
precision. These attributes
include Measures, CO2e,
and Total CO2e on the
Sustainability Activities
page.

Usage Level

This profile option is

no longer supported.

Use the Item Validation
Organization (ORA_SUS_
ITEM_VALIDATION_ORG_
CODE) profile option
instead.

Only items enabled in Site
the specified validation
organization can be

referenced on an activity or
emission factor mapping.

Setting a value for this
profile option is required if
you want to create activities
referencing an inventory
item. See What's new
Update for 25A: New Profile
Option for Item Validation
Organization for more
details.

The calculator will convert ~ Site
carbon dioxide equivalent

(CO4e) to this common unit

of measure for reporting

and roll up across activities.

Note that Oracle
recommends not to change
this profile value after
creating activities.

The default value of this Site
profile option is 5. See

What's new Update for 25A:
Configure Decimal Precision

on Emission Factor and

Emission Fields for more

details about this profile

option

Not applicable
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Profile Option Code

ORA_SUS_EXPANDED_
DECIMAL_PRECISION

ORA_SUS_CUR_
CONVERSION_RATE_TYPE

ORA_SUS_DEFAULT_
ACTIVITY_CLASSIFICATION

ORA_SUS_FBDI_COMMIT_
SIZE

ORACLE

Profile Display Name

Expanded Decimal
Precision

Currency Conversion Rate
Type

Default Activity Type for
Invoice Classification

Commit Size for Import
Sustainability Activities
Batch Process

Description

Controls the decimal
display of attributes that
require a relatively higher
precision. These attributes
include Factor and
Emissions on Sustainability
pages in the application.

Specify the currency
conversion rate type.

Specifies the activity

type to be assigned to
sustainability activities
when no classification rules
apply for a payables invoice
or the classification on the
rule isn't valid.

Specify the number of
activities that will be
taken for processing
together when importing
sustainability activities.
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Usage Level
The default value of this Site
profile option is 5. See

What's new Update for 25A:

Configure Decimal Precision
on Emission Factor and
Emission Fields for more
details about this profile
option.

The rate type is used Site
when converting the
measure currency to

the emission factor
denominator currency
with a currency conversion
rate based on the activity
date. When emissions are
calculated using spend-
based emission factors
and the currency in the
activity is different from
that of the emission factor
denominator, currency
conversion is applied for
the emission calculation.

Do not select User as the
profile value as it is not
supported.

This profile option is Site
used in the “Generate
Sustainability Activities

from Payables Invoices”
scheduled process when

creating an activity for an

invoice distribution that

doesn't qualify for any

active invoice classification

rules.

Because most activities
from Payables Invoices
would be classified

as Purchased Goods

and Services, Oracle
recommends that you
choose the Purchased
Goods and Services activity
type for this profile.

Oracle recommends notto = Site
set a value for this profile

option. The default value

for this profile option is

100000.
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Profile Option Code Profile Display Name Description Usage Level
ORA_FND_SEARCH_EXT_  Enable/Disable Search Ext = This profile is used to Controls the search Site
ENABLED Framework check if Search Extensionis capability on the

enabled. Sustainability Activities and

Emission Factor Mappings
pages. Set the profile value
to Yes.

Note: To set profile values for the preceding profile options, you must be assigned a role to access the Manage
Sustainability Profile Options and Manage Administrator Profile Values tasks.

1. To search for all profile options listed in the preceding table except the ORA_FND_SEARCH_EXT_ENABLED
profile option:
a. Inthe Setup and Maintenance work area, go to the Manage Sustainability Profile Options task:
- Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement
- Functional Area: Sustainability
b. On the Manage Sustainability Profile Options page, click Search.
c. From the search results, look for and select the profile option code or profile option display name for
which you want to set profile values.
2. To search for the ORA_FND_SEARCH_EXT_ENABLED profile option listed in the preceding table:
a. Inthe Setup and Maintenance work area, search for and select the Manage Administrator Profile
Values task.
b. On the Manage Administrator Profile Values page, search for and select the
ORA_FND_SEARCH_EXT_ENABLED profile option code.
3. Inthe Profile Values section, set the value as recommended in the Usage column of the preceding table.
4. Click Save.

Create Global Warming Potentials

Oracle Fusion Cloud Sustainability uses Global Warming Potentials (GWPs) to calculate CO,e emissions for greenhouse
gases other than CO, that are associated with the activity types you've defined.

Before you start
To perform this procedure, you must be assigned a role to access the Manage Global Warming Potentials task.

1. Inthe Setup and Maintenance work area, go to the Manage Global Warming Potentials task:
o Offering: Manufacturing and Supply Chain Materials Management, Product Management, or
Procurement
o Functional Area: Sustainability
2. On the Global Warming Potentials page, click Add GWP.
3. Inthe New GWP drawer, select an emission type and optionally enter a description.

Note: If you plan to use the CO, and CO,e emission types, then ensure to set their GWP values to 1.

4. Inthe GWP field, enter the GWP value corresponding to the emission type.
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5. Enter a start date. The default value is the system date.
6. Click Create. Or, click Create and Add Another to create more GWPs.

The GWP is created.

Configure Emission Factor Mappings

You can either create emission factor mappings directly in Oracle Fusion Cloud Sustainability or upload them from an
Oracle Visual Builder (VB) Add-in for Excel spreadsheet that you generate.

If you have only a few emission factor mappings (for example, from your suppliers) to use, then you can quickly
create them in Oracle Sustainability by using the Emission Factor Mappings page. You can access the Emission Factor
Mappings page from Navigator > Sustainability > Sustainability Activities > Emission Factor Mappings tab.

If you want to upload emission factor mappings in bulk, then use the VB Add-in for Excel spreadsheet. Oracle doesn’t
provide a predesigned and published Oracle Visual Builder (VB) Add-in for Excel spreadsheet for emission factor
mappings because the spreadsheet includes columns for activity type attributes that are specific to your organization.
Therefore, you'll need to design the layout as per your business requirements, and then populate and upload emission
factor mappings as follows:

Generate Emission Factor Mappings Spreadsheet

« Populate and Upload Emission Factor Mappings

Related Topics
» What's new for Update 25A: Create and Manage Emission Factor Mappings

Generate Emission Factor Mappings Spreadsheet

You must now generate Oracle Visual Builder (VB) Add-in for Excel spreadsheets for every activity type that you
had previously defined while performing the procedure described in Configure the Emission Factor Map Descriptive
Flexfields.

Before you start

Download and install Oracle Visual Builder Add-in for Excel from here: https://www.oracle.com/downloads/cloud/visual-
builder-addin-downloads.htmi.

1. Open a blank Microsoft Excel workbook with Oracle Visual Builder Add-in for Excel installed.
2. Create a catalog for emission factor mappings as follows:
a. On the Oracle Visual Builder tab, click Manage Catalogs.
b. Inthe Manage Business Object Catalogs dialog box, click Add, and then select Import Business Object
Catalog From Service Metadata.
c. Inthe Business Object Catalog Editor, enter the following URL in the Web address field:

https://HOST_NAME /fscmRestApi/resources/11.13.18.05/emissionFactorMappings/describe

In the URL, replace HOST_NAME with the host name of your Fusion instance.

d. Click Next.

e. On the Sign In page, enter the sign in credentials for the user who has been assigned a role that includes
the Manage Emission Factor (SUS_MANAGE_EMISSION_FACTORS_PRIV) privilege.
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A message confirming successful creation of the catalog is displayed.
f. Review the catalog details and then click Finish.
g. On the Manage Business Object Catalogs dialog box, click Done.
3. Create a new layout for emission factor mappings as follows:
a. On the Oracle Visual Builder tab, click Designer.

b. Inthe New Layout Setup dialog box, ensure that the emissionFactorMappings catalog is selected and
click Next.

Select the Emission Factor Mappings business object and click Next.
Select the Table Layout option and click Next.

Select the Emission Factor Map DFF checkbox and click Next.
Confirm the details of the new layout and click Finish.

-0 9 n

The spreadsheet is populated with all columns from the REST API.
4. Inthe Layout Designer for your table, choose the columns that must appear in the spreadsheet as follows:
a. On the Columns tab, click Manage Columns (+) .

b. In the Table Column Manager dialog box, in the Business Object pane, deselect all fields that end with ID.
Ensure that all entries under the Emission Factor Map DFF business object are selected.

c. Inthe Selected Fields pane, look for and double-click the Activity Type* (Emission Factor Map DFF)
field.

The Business Object Fields Editor - __FLEX_Context dialog box is displayed.

d. On the Polymorphic Information tab, select Limit discriminator values and the activity type for which
you are creating emission factor mappings. Select the activity type (for example Stationary Combustion)
that you set up in Configure the Emission Factor Map Descriptive Flexfields.

e. Click Done.

f. For the ease of copying over data from the accelerator spreadsheet subsequently, you might want
the columns in the VB Add-in sheet to be consistent with the ones in the Emission Factor Mappings
accelerator spreadsheet. To do so, on the Selected Fields pane, reorder the columns as required. Note
that the Activity Type* (Emission Factor Map DFF) field will create a column for activity type and
columns for its attributes.

g. Click Done.

h. Rename the spreadsheet tab to reflect the name of the activity type.

i. Save the spreadsheet.

5. Configure the Query Parameter to download emission factor mappings for the activity type as follows:

a. Inthe Layout Designer, click the Query tab.

b. Click Add Search Parameter (+).

The Search Parameter Editor is displayed.

c. Inthe Parameter Name field, enter q, in the Parameter Value field, enter
EmissionFactorMapDFF.__FLEX_Context ='ACTIVITY_TYPE '. Here, replace ACTIVITY_TYPE with
activity type name for which you are creating the emission factor mapping. For example, Stationary
Combustion.

d. Click OK.

6. Save the spreadsheet.
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7. If you want to publish the template, then:
a. On the Oracle Visual Builder tab, click Publish.

b. In the Publish Workbook dialog box, browse to the location where you want to publish the template and
also enter a name for the same. For example, Stationary Combustion Emission Factor Mappings.xIsx.

c. Ensure that only the Clear all authentication properties checkbox is selected, and then click Publish.
8. If you want to generate VB Add-in sheets for additional activity types, then replace the Query Parameter and
Polymorphic Information for the activity type and save a separate spreadsheet as follows:
a. Inthe Layout Designer, on the Query tab, double-click the previously added search query and expression.
b. Inthe Search Parameter Editor, in the Parameter Value field, replace the previous activity type
name with the current activity type name. For example, if you're creating emission factor mappings
for waste generated in operations activity type, then the value in the Parameter Value field is:
EmissionFactorMapDFF.__FLEX_Context = 'Waste Generated in Operations'
Ensure that the Allow expressions in Parameter Value checkbox is selected and click OK.
d. On the Columns tab, double-click Activity Type*. The Business Object Fields Editor - _ FLEX_Context
dialog box is displayed.
e. On the Polymorphic Information tab, select the additional activity type and deselect any others. For
example, select Waste Generated in Operations and deselect Stationary Combustion.
f. Click Done.
Rename the spreadsheet tab to reflect the name of the activity type.
Save the spreadsheet by naming it to reflect the new activity name. For example, Waste Generated in
Operations Emission Factor Mappings.xIsx.
i. (Optional) Publish this template as described in Step 7.

o

= q

Related Topics
« Documentation for Oracle Visual Builder Add-in for Excel

Populate and Upload Emission Factor Mappings

You must populate the Oracle Visual Builder Add-in for Excel spreadsheets that you created earlier for emission factor
mappings and then upload the values to Oracle Fusion Cloud Sustainability.

1. Open the published VB Add-in spreadsheet for your activity type.
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2. Copy data from the relevant tab in the Emission Factor Mappings accelerator spreadsheet that you prepared as
follows:
a. Open the Emission Factor Mappings accelerator spreadsheet and navigate to the sheet containing data
for the activity type that you want to track.
b. Copy the data from this sheet into the corresponding VB Add-in spreadsheet that you created and
optionally published for your activity type.

Note:
- Copy only those entries that you intend to use to keep the data to a minimum.
- Upload any emission factor mappings from the accelerator spreadsheet for the
most recent calendar year. End-date any older mappings to a date before the new
mappings' start date.

c. For any data validation errors, verify that the values for currencies, UOMs, and other attributes are
configured in your environment.

d. If you're using emission factors from multiple sources for an activity type and maintaining them in
separate tabs of the accelerator spreadsheet, then copy data from these tabs into the same VB Add-in
spreadsheet.

e. Date in the Start Date column for an emission factor mapping in the VB Add-in spreadsheet defaults to
the system date. With this default date, any activity whose start date is in the past will not be able to use
the emission factor. Therefore, it's important to enter start dates that are earlier than the dates of the
expected activities.

f. Enter values in the Ranking column as it's a required field. Assign the same ranking to all emission factors
from the same source and rank the sources relative to one another. This will help you organize your
emission factors and rankings. Assign rankings using numbers that leave room for inserting values in the
future. For example, use a ranking sequence such as 100, 200, 300, and so on instead of a sequence like
1,2, 3, and so on.

g. Don't populate the Change, Status, and Key columns. The application will automatically populate values
in these columns.

h. For the mobile combustion activity type, if you're using emission factors from United States
Environmental Protection Agency (US EPA), then leave the Percent Laden column blank.

3. From the Oracle Visual Builder tab, click Upload Changes. The Upload dialog box showing the upload progress
is displayed.

4. Verify that the Status column contains "Create Succeeded" for each populated record in the spreadsheet tab.

5. (Optional) To see all the emission factor mappings that have been uploaded, from the Oracle Visual Builder tab,
click Download Data. The spreadsheet will be populated with the required data.

Tip: When uploading emission factor mapping revisions, if the calculator finds two or more emission factors for an

activity and emission type that have the same ranking, then it will use all of them and calculate multiple emission
records. To avoid this scenario, be sure to end-date any earlier versions before the new revision’s start date.

Configure Invoice Classification Rules

If you're using Oracle Fusion Cloud Financials for managing supplier invoices, then you can create invoice classification
rules to automatically generate activities corresponding to the goods and services procured from suppliers. For any
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invoice distributions that can't be classified using these rules, Oracle Fusion Cloud Sustainability provides optional Al
capabilities to classify them automatically.

Invoice classification rules use fields that are present on the Payables invoice to tell Oracle Sustainability what kind
of activity must be created for each invoice distribution. When you run the Generate Sustainability Activities from
Payables Invoices scheduled process, Oracle Sustainability fetches eligible invoice distributions and applies rules to
create corresponding activities for each invoice distribution. Then, it automatically runs emission calculations and
validations whose results you can review on the Sustainability Activities page.

You can either create rules directly in Oracle Sustainability or upload them from the published Oracle Visual Builder
Add-in for Excel spreadsheet that Oracle provides. However, to improve coverage by rules overtime, you can use the
optional Al capabilities of Oracle Sustainability to suggest rules for you.

Related Topics
« What's new for Update 25B: Classify Invoices Using Al

« What's new for Update 25B: Get Al-Suggested Invoice Classification Rules

Prerequisites for Configuring Invoice Classification Rules
Perform these tasks before you create invoice classification rules.

Before you start

To perform this procedure, you must be assigned a role that has all the privileges of the predefined Sustainability
Analyst role.

1. Ensure that you have emission factor mappings configured and uploaded.
2. Sync activity classifications as follows:
a. Click Navigator > Sustainability > Invoice Classification Rules.

b. On the Invoice Classification Rules page, click Sync Activity Classifications. This will populate the list of
values for the Activity Classification field when you create a rule.

Note: Each time you create emission factors for a new combination of activity type and activity type
attributes, ensure to sync activity classification so that the newly added combinations are added to the
Activity Classification list.

Understand Invoice Classification Rules

Invoice classification rules allow Oracle Fusion Cloud Sustainability to determine which activity type and activity type
attribute to use when generating an activity for an eligible invoice distribution, by using fields on the invoice, line, and
distribution.

Every invoice classification rule requires the following attributes:

Name: Enter a unique name for the rule.

- Start and End Dates: Use these dates to determine which rules are active or inactive at any given point in time.
If you don't need a rule to be applicable anymore, then you enter an end date that specifies the date from which
the rule becomes inactive.
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- Rule Type: Can be either Exclude or Assign.

o Exclude: Choose this option when creating a rule to identify invoice distributions that must not be used to
create activities. For example, you can use this option for a distribution that does not have any emissions
impact.

o Assign: Choose this option when creating a rule to identify invoice distributions that must be used to
create activities.

- Rank: Specify a rank to sequence the rule execution. This is applicable only for rules of the type Assign. Rules
with a lower rank number are executed first. If an invoice distribution meets the conditions of a rule, then the
remaining rules are not evaluated for the distribution.

- Activity Classification: Choose the combination of activity type and activity type attributes that must be
assigned to the generated activity. During implementation, the activity classification is generated from valid
combinations of activity type attributes that are included in the emission factor mappings that you configured.
Activity classification is generated by concatenating the activity type and activity type attributes following
the same sequence as configured in the emission factor map descriptive flexfield. Values not populated will
be skipped. For example, if you had configured the Mobile Combustion activity type to have three context-
sensitive segments in the sequence Energy Source, Vehicle Type, and Percentage Laden, and you had
configured the Stationary Combustion activity type to have a single context-sensitive attribute Fuel Type, then
the following table shows the corresponding activity classification that will be generated.

Examples of Activity Classification

Activity Type Energy Source Vehicle Type Percentage Laden Fuel Type Activity
Classification

Mobile Combustion = Diesel Heavy Duty Trucks Mobile
Combustion.Diesel.Heavy
Duty Trucks

Mobile Combustion = Diesel Passenger Car 100 Mobile
Combustion.Diesel.Passenger
Carl100

Mobile Combustion = Diesel Mobile
Combustion.Diesel

Stationary Bituminous Coal Stationary

Combustion Combustion.Bituminous
Coal

Stationary CNG Stationary

Combustion Combustion.CNG

- Conditions: Specify one or more conditions that invoice distributions must meet to use this rule. If you define
multiple conditions for a rule, then you can specify whether the given invoice distribution must meet all the
conditions or any of the conditions to use this rule.

a. Attribute: Specify conditions on any of the following attributes on the invoice:
- Invoice type: The type of invoice, such as Standard, Prepayment, Credit memo, and so on.
- Item: ltem on the invoice line.
- Item description: The description of the item on the invoice line.
- Legal entity: Legal entity on the invoice.
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Line description: Invoice line description.
Line type: For example, Item, Tax, Miscellaneous.

Natural account: Natural account number segment value of the charge account used on the
distribution.

Natural account description: The description of the natural account.

Procurement category hierarchy 1-10: Category value at one of the procurement category hierarchy
level.

Purchasing category: Category assigned on the purchase order, for invoice lines matched to
purchase orders.

Ship-to location

Supplier name

Supplier site

Business unit

Transaction description: Invoice description.

Unit of measure: Unit of measure on the invoice line.
Amount: Amount on the distribution.

Quantity: Quantity on the distribution.

b. Operator: Use one of these operators to write your condition:

Comparison Operators

Operator Explanation

Contains The selected invoice attribute contains the keyword in the condition value.

For example, the keyword light, when compared with the value Floodlight, will be
considered a match. The keyword is case sensitive.

Does not contain The selected invoice attribute does not contain the keyword in the condition value. The

keyword is case sensitive.

The value of the selected invoice attribute exactly matches with the condition value. This
is not case sensitive.

Is empty The selected invoice attribute has no value.
Is not empty The selected invoice attribute contains a value.
Is exactly The value of the selected invoice attribute exactly matches with the condition value. This

Is not

ORACLE

is case sensitive.

The selected invoice attribute does not match with the condition value. This is case
sensitive.

For example, a condition where the supplier’s name is not Light will match invoice
distributions with any supplier name other than Light.
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Starts with and Ends with

Matches any and Matches none
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Explanation

The selected invoice attribute starts or ends with the condition value. This is case
sensitive.

For example, a condition where the supplier's name starts with Corp will match all
transactions with supplier names such as Corporation Tech, Corp Tronics, and so on.

Similarly, ends with matches all transactions with supplier names such as Green Corp,
Vision Corp, and so on.

The selected invoice attribute matches with any of the keywords in the condition value.
You can enter multiple keywords in the condition value, separated by the number sign (#).
The values are case sensitive.

For example, suppose that you want to create rules to differentiate between the purchase
of computer hardware and computer services. You can procure either of these from three
known vendors: Supplier 1, Supplier 2, or Supplier 3.

If the invoice line description contains Laptop, then we must consider a hardware
purchase. Otherwise, it's a software purchase. For this scenario, we can define two rules as
follows:

Rule 1

Rule name: Hardware

Rank: 150

Activity classification: Purchased Goods and Services.Computer hardware

Rule Condition Type - All

Rule condition 1: Supplier name Matches any Supplier 1#,Supplier 2#,Supplier 3

Rule Condition 2: Line description Contains laptop

Rule 2

Rule name: Software

Rank: 200

Activity classification: Purchased Goods and Services.Software and Software Services
Rule Condition Type: All

Rule condition: Supplier name Matches any Supplier 1#,Supplier 2#,Supplier 3
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c. Value: Enter a value for the expression to be evaluated.

- When rules are evaluated, all the exclusion rules are evaluated first and activities are not created for any invoice
distributions that match the exclusion rules. Then, all the assignment rules are executed one after the other in
the sequence of ranking.

Exclusion Rules
For example, consider the following scenarios:
Scenario 1: You want to exclude all invoices of the type Prepayment.

Scenario 2: You want to exclude all invoices from Vision Corporation because they send detailed emission data
for the fleet they manage on your organization's behalf. The emission data is configured to be uploaded directly
to Oracle Sustainability through your own integration with the systems of Vision Corporation. Therefore, you
don't want to generate activities directly from their invoices.

In both these scenarios, you can create exclusion rules as follows:

Sample Exclusion Rules
Rule Name Rule Description Rule Condition
Exclude all Prepayment Exclude all invoices of type Prepayment Invoice type Is Prepayment
Exclude invoices from Vision Corporation Exclude all invoices from Vision Corporation  Supplier name Is Vision Corporation

Assignment Rules
For example, consider the following scenarios:

Scenario 1: You procure IT Hardware from several vendors. All these purchases originate from the procurement
system, where the Purchasing Category is clearly identified as IT Hardware. Therefore, any invoice lines
matched with Purchase Order (PO) lines that use the Purchasing Category “IT Hardware” must result in an
activity of type “Purchased Goods and Services.Computers” (the activity type should be Purchased Goods and
Services, and the Spend Type should be Computers).

Scenario 2: You procure natural gas for running furnaces on your shop floor, and emissions must be accounted
for as Scope 1 - Stationary Combustion. All the natural gas is procured from a supplier named Green Corp.
This supplier provides other fuels too, so for a purchase of natural gas, the line description always contains the
words “natural gas.” Also, only the invoices charged to one of the many natural accounts containing the word
“Furnaces” must be considered for Stationary Combustion. Therefore, any invoice distribution that matches all
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the following criteria must result in activities of type Stationary Combustion.Natural Gas (here, the activity type
should be Stationary Combustion, and the fuel type should be Natural Gas):

o Is charged to natural account that contains the word "Furnaces".
o Invoice line description contains the words “Natural gas."

o Supplier is Green Corp.
In both these scenarios, you can create assignment rules as following:

Sample Assignment Rules

Rule Name Rule Description Rule Condition Type Rule Condition Activity Classification
IT Hardware PO for IT Hardware Purchasing category Is IT = Purchased Goods and

category Hardware Services.Computers
Natural gas for furnace Natural gas for furnace All Natural account Contains = Stationary

must result in emission Furnaces Combustion.Natural Gas

under Stationary

Combustion Line description Contains

Natural Gas

Supplier Is Green Corp

Create Invoice Classification Rules

You can create invoice classification rules by using the Invoice Classification Rules page.

Before you start

To perform this procedure, you must be assigned a role that has all the privileges of the predefined Sustainability
Analyst role.

1. Click Navigator > Sustainability > Invoice Classification Rules.
2. On the Invoice Classification Rule page, click Create Rule.
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3. Onthe New Rule page, create a rule as follows:

a. Inthe Name field, enter the rule name.

b. From the Start Date field, select the data from which the rule will be active. Optionally, enter an end date
to specify the date from which the rule will turn inactive.

c. From the Rule Type drop-down list, select Assign to create assignment rules, and select Exclude to
create exclusion rules.

d. Inthe Rank field, enter a unique rank number that is used for sequencing the rule execution. This is
applicable only for assignment rules.

e. From the Activity Classification drop-down list, select the required activity type and activity type
attributes combination. This is applicable only for assignment rules.

f. Inthe Conditions sections, select All or Any to specify whether all conditions must be met or any
condition must be met to run the rule.

g. To create rule conditions, click the Create icon.

h. Inthe New Condition drawer panel, specify the invoice attribute on which the condition must be applied,
From the Operator drop-down list, select the comparison operator for the rule. Then, enter a value for the
attribute

i. Click Save.
J- To add more conditions, repeat steps 3.g through 3.i.
4. Click Save.

Upload Invoice Classification Rules

Oracle provides a published Oracle Visual Builder Add-in for Excel spreadsheet that contains a predesigned table layout
for invoice classification rules. Use this spreadsheet to upload invoice classification rules in bulk.

Tips for Preparing Your Accelerator Spreadsheet for Invoice Classification Rules

Ensure that all rules of the Assign type have a unique rank number. All rules of the Exclude type must have a
rank of -1.

Ensure that you populate the rule conditions for each rule. Also, ensure that the rules are meaningful. The
Generate Sustainability Activities for Payables Invoices schedule process will end in error if it detects rules
without conditions or with improperly written conditions.

- Activity Classification must be specified for all rules of the Assign type. This must be constructed using the
following format:

<Activity Type Name>.<Activity Type Attributel>.<Activity Type Attribute2> . . .

For example, Stationary Combustion.Gasoline, Mobile Combustion.Battery Electric Vehicle.Average car.

Before you start

Download and install Oracle Visual Builder Add-in for Excel from here: https://www.oracle.com/downloads/
cloud/visual-builder-addin-downloads.htmi.

Download the Invoice Classification Rules - Published spreadsheet from Oracle Cloud Customer Connect.
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The following are the high-level steps for configuring and uploading invoice classification rules using the published VB
Add-in spreadsheet:

1. Review the sample rules in the accelerator spreadsheet for invoice classification rules and replace them with

rules that meet your business needs.

Open the Invoice Classification Rules - Published spreadsheet.

From the Oracle Visual Builder tab, click Download Data. The Service Configuration dialog box is displayed.

In the Service host field, enter the URL of your Fusion instance and then click OK.

On the Sign In page, enter the credentials for the user that has been assigned a role with the privileges of the

predefined Sustainability Analyst role. Data is downloaded and displayed in the spreadsheet.

Copy data from the Invoice Classification Rules accelerator spreadsheet that you've prepared to corresponding

VB Add-in spreadsheet. While doing so, don’t populate the Change, Status, and Key columns. The application

will populate these during this step and the next.

7. From the Oracle Visual Builder tab, click Upload Changes. The Upload dialog box showing the upload progress
is displayed.

8. Verify that the Status column contains "Create Succeeded" for each populated record in each spreadsheet tab.

v WN

o

Get Suggestions for Invoice Classification Rules

By using the optional Al capabilities of Oracle Fusion Cloud Sustainability, you can get recommendations for invoice
classification rules.

Before you start

To perform this procedure, you must be assigned a role that contains the Manage Invoice Classification Rule for
Sustainability Activities (SUS_MANAGE_INVOICE_CLASSIFICATION_RULES) privilege.

To get rule recommendations, from the Actions menu on the Invoice Classification Rules page, select Suggest Rules.

Related Topics
« What's new for Update 25B: Get Al-Suggested Invoice Classification Rules

Configure Search Views

Search views define the attributes that are enabled for keyword searches, and for display as filter chips or columns in
search results on the Sustainability Activities and Emission Factor Mappings pages. If you want to modify the default
search view or create a new search view (for common searches or reports) based on your requirements, then configure
search views.

Before you start

To configure search views, you must be assigned a role that includes the Manage Search Views
(HRC_MANAGE_SEARCH_VIEWS) privilege.

You can access the Search Views page in any of the following ways:

- Click Navigator > My Client Groups > Show More > Data Exchange work area > Search Views from the
home page.
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- Click Navigator > Tools > Deep Links from the home page. Then, on the Deep Links page, click Redwood
Quick Actions. On the VBCS Deep Links page, from the View drop-down list, select My Client Groups, and
from the Data Exchange section, select Search Views.

- Navigate to the following URL:
https://HOST_NAME/fscmUIl/redwood/human-resources/search-config/

In this URL, replace HOST_NAME with the host name of your Fusion instance.

Related Topics
« What's new for Update 25A: Configure Search Views for Sustainability Activities and Emission Factor Mappings

« What's new for Update 25B: Find Activities or Emission Factor Mappings Using Activity Type Attribute Values as
Keywords
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5 Create or Import Activities

Create Activities

Create activities manually in Oracle Fusion Cloud Sustainability.

Before you start

Ensure that the period in which you plan to create activities is in the Open status.
Ensure that you're assigned a role that has all the privileges of the predefined Sustainability Analyst role.

To create activities:

10.

n.

Click Navigator > Sustainability > Sustainability Activities.
On the page that displays the dashboard for sustainability activities, click the Activities tab at the bottom of the
page.
On the Sustainability Activities page, click Create Activity.
On the New Activity page, in the Classification section:
a. From the Activity Type drop-down list, select the type of activity that you want to create.

The corresponding fields for the specified activity type are displayed.
b. Specify values for all the activity type attributes, scope, and scope category (if applicable) fields.
In the Activity details section, specify values for any relevant fields such as Description, Activity Date, Legal
Entity, Country, Supplier, and Item. Note that specifying a value for the Legal Entity drop-down list is required.

Specify values for any additional fields that might be available for the activity type that you are creating.
If your selected activity type has associated measure types, then in the Measures section, create measures by
clicking Add. In the Add measure drawer panel, select the measure type and specify its details, and then click
Add. Or, click Add and Create Another to add more measure types.
If your selected activity type has associated emissions, then from the Emissions section, select one of the
following calculation modes:
o Using matched factors: Select this option if you want Oracle Sustainability to calculate emissions based
on the emission factor mappings that was configured during implementation.
o Manual entry of factors: Select this option if you want Oracle Sustainability to calculate emissions by
using emission factors that you specify on the activity.
o Manual entry of emissions: Select this option when you want to directly specify emission that are
calculated externally.
If you selected Manual entry of factors, then click Add Emission. In the Add emission drawer panel, select the
emission type, measure, factor, and other related values, and click Add or Add and Create Another.
If you selected Manual entry of emissions, then click Add Emission. In the Add emission drawer panel, select
the emission type, emission quantity, emission UOM, and then click Add.
In the Data Source section, the source type is automatically generated. For example, for activities being created
manually in Oracle Sustainability the source type is Manual Entry. Similarly, for activities generated from
Payables invoices, the source type is Payables Invoices and a link to the source invoice is available. Optionally,
in the External Reference Number field, specify the reference number to link this activity with any external
document.
In the Ledger section, the sustainability ledger and period fields are grayed out. These values are derived
automatically when you save or create an activity. A sustainability ledger and period are automatically derived
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12
13.

14.

based on the legal entity and activity date that you specified earlier, respectively. If the period derived is closed,
then the next open future period is defaulted. In the Edit mode, you can update the period from a list of open
periods associated with the ledger.

(Optional) In the Comments section, enter any comments for the activity.

In the Additional information section, enter values for the relevant fields. These are the fields that your
organization would have configured using descriptive flexfields.

Click Save to calculate the emissions, if any, and create the activity. The activity is created and the New Activity
page title will change to display the activity ID and the activity type that was created. Optionally, you can click
Save and Close.

Tip: To track fugitive emissions, create activities by selecting the Manual entry of emissions calculation mode. Upon
saving the activity, the emission calculator will apply the global warming potentials to calculate COze. If the fugitive
emissions are from a vehicle, then create separate activities to track mobile combustion and fugitive emissions.

Generate Activities from Payables Invoices

You can automatically generate activities from Payables invoices by running the "Generate Sustainability Activities from
Payables Invoices" scheduled process.

Generate Activities

Note: Before you run the scheduled process, ensure that you have:

Been assigned a role that includes the Generate Sustainability Activities from Payables Invoice
(SUS_GENERATE_ACTIVITIES_FROM_INVOICES) privilege.

- Set a value for the Default Activity Type for Invoice Classification profile option.

When you run the "Generate Sustainability Activities from Payables Invoices" scheduled process, it performs the
following actions:

1.
2,

Selects invoice distributions that meet the criteria specified in the invoice classification rules.

Identifies eligible invoice distributions to be processed into activities. The following invoice distributions will be
excluded for processing into activities:

o Distributions that aren't fully validated and accounted.
o Distributions for which activities are already generated.
o Distributions that meet the criteria for any active exclusion rules.

Evaluates each eligible invoice distribution against each active invoice classification rule in the order of the rank
specified in the invoice classification rule.
a. If aninvoice distribution meets the criteria for a given invoice classification rule, then an activity is
created using the activity classification specified on that rule. The following table lists the fields that are
copied from the invoice distribution to the activity or defaulted based on the setup.
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Fields on the Resulting Activity

Description
Activity Date
Legal Entity
Supplier
Country

ltem Number

Activity Type

Activity Type Attributes

Scope and Scope Category

Measure for Amount

Measure for Quantity

Invoice Number, Line Number and

Distribution

Source Type

Chapter 5
Create or Import Activities

Mapping of Fields between an Invoice Distribution and the Corresponding Activity

Derivation Source

Invoice line description

Accounting Date on the invoice line

Legal Entity on the invoice

Supplier on the invoice

Country specified in the Ship-to line of the invoice
Item Number on the invoice line

Based on the activity classification on the rule that was used.
If no rule was applied, then the activity type is derived from the Default Activity Type for
Invoice Classification profile option.

Based on the activity classification on the rule that was used.
If no rule was applied, then no values will be populated for the Activity Type attributes of
the default activity type.

From the activity type definition for the selected activity type.

Invoice distribution amount and currency are used to create an amount measure, if the
activity type has been set up to use the predefined Amount measure.

Invoice distribution quantity and UOM are used to create a quantity measure, if the
activity type has been set up to use the predefined Quantity measure.

From the source invoice.

From Payables Invoice.

b. Rule evaluation continues in the order of rank until a matching rule is identified.

c. If you've opted for the optional Classify Invoices Using Al feature, then Oracle Fusion Cloud
Sustainability will attempt to classify any remaining distributions using Al. If the classification is predicted
with high confidence, then the activity will be created using the activity type and activity type attributes
predicted by Al.

d. If Al can't predict with high confidence, or if you didn't opt-in to the Classify Invoices Using Al feature,
then Oracle Sustainability uses the Default Activity Type for Invoice Classification profile option to
classify any remaining distributions.
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4. For each activity that's created, the scheduled process:
a. Triggers emission calculation using the preconfigured matched emission factors and the measures
derived from the invoice.

b. Runs the validation check that helps you identify activities that are incomplete and thus need your
attention.

After the successful completion of the "Generate Sustainability Activities from Payables Invoices" schedule process,

for each eligible invoice distribution (only distributions that are fully validated and accounted for), activities are created
and placed in the Draft status. On the Sustainability Activities page, you can search for activities by using the payables
invoice number or the invoice classification rule. You can individually post each activity to the ledger after reviewing it,
or run the “Process Sustainability Activities” scheduled process to post a large volume of activities to the ledger in bulk.

Tips and Considerations

- If you opt in to the Classify Invoices Using Al feature, then be sure to define at least four emission factor
mappings for the activity type specified in the Default Activity Type for Invoice Classification profile option.

« Purge the interface table data of External Purchase Prices and the corresponding records in error tables if
applicable.

- Only the predefined measure types Quantity and Amount are automatically derived from the invoice. To
automatically calculate emissions from invoices, you must configure the Quantity and Amount measure types
for the activity types of the activities that will be generated from invoices.

- For deriving the Quantity measure from the invoice line or distribution, both Quantity and UOM must be
specified on the invoice. If there's incomplete information (for example, UOM is missing), none of the measures
will be copied over. The activity will be tagged with a missing measures alert for Sustainability Analysts to enter
correct measures and ensure calculation accuracy.

- It is possible that a fully validated and accounted invoice can still be modified in Payables. Oracle Sustainability
doesn't consider any changes to invoice distributions after the invoice has been processed into activities.
Canceling an invoice distribution creates a new distribution with negative amount and quantity. The new
distribution generates a new activity that subtracts the quantities and emissions of the original distribution.

Related Topics
- Generate Sustainability Activities from Payables Invoices

« Process Sustainability Activities

Import Activities Using FBDI Templates

Import sustainability activities, along with measures and emissions, from external sources using file-based data import
(FBDI). Use FBDI to create large volumes of activities.

You can also use FBDI to edit or delete large volumes of activities.

Before you start

To import, edit, or delete activities using FBDI, you must be assigned a role that has all the privileges of the predefined
Sustainability Integration Specialist role.
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For complete details on using FBDI, refer to either of the following guides:

Oracle Fusion Cloud SCM File-Based Data Import (FBDI) for SCM

Oracle Fusion Cloud Procurement File-Based Data Import (FBDI) for Procurement
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6 Review and Manage Activities

Review Activities

Oracle Fusion Sustainability Cloud provides a dashboard to get insight into the activities that require attention for the
earliest open period that is targeted to be closed. The dashboard helps you to understand the total number of draft
activities that need to be posted and the percentage of draft activities that have validation errors.

On the dashboard, you can analyze activities by alert type and by status. In addition, you can extend the dashboard to
create your own scorecards by adding KPIs and data visualizations that are critical for your business.

To review activities on the dashboard:

Note: To perform this procedure, you must be assigned a role that includes the View Sustainability Activity Work Area
(SUS_VIEW_SUSTAINABILITY_WORKAREA_PRIV) privilege.

1. Click Navigator > Sustainability > Sustainability Activities
The Sustainability Activities page with the dashboard is displayed.
2. From the drop-down list next to the page title, select the sustainability ledger from which you want to review
activities.
3. Click the stacked bar chart to review validation errors by activity type and then drill down to the list of activities.
In addition, use the activity type legend preceding the stacked bar to review only selected activity types at a
time.
4. C(lick the pie chart to review activities by different statuses and then drill down to the list of activities. In
addition, use the status legend preceding the pie chart to review only selected statuses at a time.
When you confirm that all activities for the current target period are posted, you can close the period using the Periods
page after which the dashboard is automatically refreshed with the metrics for the next available open period.

Related Topics
« What's new for Update 25C: Extend the Activities Dashboard with OTBI KPIs and Visualizations

Manage Activities

Use the Sustainability Activities page to view, create, edit, and search for activities.

After you search for and view an activity, you can perform actions such as validate, post, and delete. You must validate
an activity in the draft status before posting it to the sustainability ledger. You can perform validations on an activity
when you view or edit the activity. In addition, validations are implicitly performed when you post an activity. Examples
of validations performed by Oracle Fusion Cloud Sustainability include ensuring that the activity type is valid and that
there are no missing measures or missing emissions. If you want to validate or post activities to a sustainability ledger in
bulk, then run the Process Sustainability Activities scheduled process.

Note: To perform this procedure, you must be assigned a role that has all the privileges of the predefined
Sustainability Analyst role.
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1. Click Navigator > Sustainability > Sustainability Activities

The Sustainability Activities page with the dashboard is displayed.
2. Click the Activities tab.

3. To search for and filter activities, enter your search criterion in the search field. The search criterion can be an
activity number, activity type, or a supplier. You can narrow down your search results by using filters such as
Activity Types, Activity Date, Classified by Al, Status, Sustainability Ledger, Period, Invoice Number, and so on.

4. From the search results, you can perform the following actions:

o

Note:

View activity details: To view details of an activity, from the search results, click the activity number link
corresponding to the activity that you want to view. For emission-generating activities, the activity details
also include information about the emissions and how they were calculated. You can click an emission
factor to view its source, ranking, and effective dates.

Edit draft activities: To edit an activity, click the pencil icon in the Actions column corresponding to the
activity. Or, click Edit while viewing an activity on the activity details page.

Delete draft activities: Select one or more activities that you want to delete and then click Delete.

Note that you can't permanently delete activities generated from Payables invoice. This is because a new
activity will be created in its place in a subsequent run of the "Generate Sustainability Activities from
Payables Invoices" scheduled process. In such a case, you can perform one of the following actions:
- Create an exclusion rule that would apply to the source invoice, and delete the activity. When the
scheduled process runs again, this invoice distribution will not be processed into an activity.

- Post the activity to the ledger and cancel it immediately.
- Update the measures to zero and save the activity. This will cause emission calculation to be zero.
Then, post the activity to the ledger.

Validate draft activities: Select one or more activities that you want to validate, and then click Validate.
Or, on the page that displays the activity details, from the Actions menu, click Validate.

Oracle Sustainability performs a series of checks in the background to ensure that the activity is ready to
be posted to the ledger. In addition, it recalculates emissions and ensures that the latest set of matching
emission factors, valid as of the activity date, are used for emission calculations. Note that you can only
post a validated activity to the sustainability ledger.

Post draft activities to ledger: Select one or more activities that you want to post, and then click Post. Or,
on the page that displays the activity details, from the Actions menu, click Post.

The activity is validated and posted to the ledger. You cannot update an activity after it's posted to the
ledger.

Cancel posted activities: Select one or more activities that are in Posted status, and then click Cancel. Or,
on the page that displays the details of a posted activity, click Cancel Activity.

You can cancel a posted activity if the period in which it's posted is still Open. After an activity is
canceled, its status changes to Canceled and you can't perform any actions on it.

Export activities: Select one or more activities that you want to export, and then click the Export icon.
You can select and export up to 10000 records at a time.

- You can select up to 500 activity records at a time and then validate, post, cancel, or delete them.

- If you don't see the updates after you validate, post, cancel, or delete two or more activity records at a time,
then refresh the page after a few minutes and check.
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7 Manage Periods

Manage Periods

Use the Sustainability Periods page to view and close periods.

You can close a period only after you've posted all the activities in that period to the ledger. You must close all periods
successively starting with the earliest open period. All activities in the period that you plan to close must be in the
Posted or Canceled status.

Before you start

You must be assigned a role that includes the Manage Sustainability Ledger Period
(SUS_MANAGE_LEDGER_PERIODS_PRIV) privilege.

1. Click Navigator > Sustainability > Sustainability Activities.

2. On the page that displays the dashboard for sustainability activities, click the Periods tab. The Sustainability
Periods page is displayed.

3. Inthe Target period to close section, click Close Period.

The Close Period button will be disabled if there are activities in this period that are in the Draft status. Review
the value of the Activities in Draft Status metric. If the value of this metric is not zero, then ensure that you
post or delete all these draft activities. The Close Period button will be enabled only when the number of
records in the Activities in Draft Status metric is O.

Related Topics
« What's new for Update 25A: Review Period Summary Before Period Close
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8 Troubleshooting

Troubleshooting

Review these suggested solutions for issues with Oracle Fusion Cloud Sustainability.

Issue: The aggregation count on the dashboard or the search pages for sustainability activities or emission factor
mappings don't match the actual activity count.

Try this: Depending on whether the mismatch is on the Sustainability Activities page or the Emission Factor Mappings
page, run the "ESS job to create index definition and perform initial ingest to OSCS" scheduled process with the Index
Name to Reingest parameter set to fa-prc-sus-activities or fa-prc-sus-efmaps, respectively. This will sync the
aggregation count and activity count.

Issue: Activities generated from Payables invoices have the wrong activity type or activity type attributes.

Try this: This issue can occur if there was no rule in place for the source invoice distribution or an incorrect rule got
applied.

As a first step, create a new rule or update existing rules to ensure that future activities from such invoice distributions
have the correct activity type and activity type attributes.

Then, to reclassify activities with issues, you can perform one of the following options:

- If the activity type is correct but one of the activity type attributes (such as Spend Type) is incorrect or isn't
populated, then you can update the activity and correct the activity type attributes. This method works if you
have only a few activities to correct.

- If the activity type is incorrect or if you have a large volume of activities that need to be corrected, then:
a. Delete the activities that need to be corrected. You can delete activities in any of the following ways:
- From the Sustainability Activities page in Oracle Sustainability.
- By using the Oracle Visual Builder Add-in for Excel spreadsheet for the Activity.
- By using File-Based Data Import (FBDI).

b. Run the "Generate Sustainability Activities from Payables Invoices" scheduled process again with
parameters that would include the source invoice distributions. A new set of activities will be created with
the correct activity type and activity type attributes as the updated set of rules are evaluated.

You can't permanently delete an activity that's generated from Payables invoice, because a new activity will get
created in its place in a subsequent run of the scheduled process. If you think the activity isn't needed, then you
can perform one of the following actions:

o Create an exclusion rule that would apply to the source invoice, and delete the activity. When the
scheduled process runs again, this invoice distribution will not be processed into an activity.

o Post the activity to the ledger and cancel it immediately.

o Update the measures to zero and save the activity. This will cause the emission calculation to be zero.
Then, post the activity to the ledger.

Issue: Activity validation issues.
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Try this: Fix any validation issues by using the resolution given in the following table. Note that you can't post activities
with validation issues to the ledger.

The following table summarizes all the validation messages implemented in Oracle Sustainability. The table also lists the
corresponding validation details and resolution.

Validations Implemented in Oracle Sustainability

Validate Message

Activity type end dated

GWP end dated

Emission factor end dated

Duplicate emissions

ORACLE

Validation Details

The activity type on the activity All calculation modes
record was end-dated in the

activity type setup.

The activity record has been All calculation modes
created with emissions and the

GWP associated with the emission

type has been end-dated in the

GWP set up.

The Activity Date on the activity
record should be between the start
and end dates of the GWP.

The activity record has been Using matched factors
created with emissions and

the emission factor mapping

associated with the emission

type has been end-dated in the

emission factor setup.

The activity date on the activity
record should be between the start
and end dates of the emission
factor mapping.

There are duplicate emissions for All calculation modes
the same emission type in the

activity. This error can occur in the

following conditions:

Applicable to Calculation Modes

Resolution

Try any of the following:

- Extend the end date of the
activity type.

Update the Activity Date so
that it is between the start
and end dates of the activity
type.

- If you no longer wish to use
the activity type, then create
a new activity as the Activity
Type field for a record is not
an editable field. Then, delete
the original activity.

Try any one of the following:

Extend the end date of the
GWP.

Update the activity date so
that it is between the start
and end dates of the GWP.

Update the GWP setup and
ensure that the emission
types in question have a valid
GWP.

Try any one of the following:

Extend the end date of the
emission factor mapping.

- Update the activity date so
that it is between the start
and end dates of the emission
factor mapping.

Update the emission factor
mappings and ensure that the
emission types in question
have a valid mapping.

s If the calculation mode is
Using matched factors,
then change the rankings
of the matched emission
factor mappings so that only
one highest ranked factor is
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Validate Message

Missing emissions

Missing measures

Emission quantity missing

ORACLE

Validation Details

- If the calculation mode is
Using matched factors,
then more than one emission
factor mapping of the same
rank matched for the same
emission type and duplicate
emissions were calculated.

- For other calculation modes,
more than one emission
line has been entered for the
same emission type.

No emissions are entered or
calculated for the activity even
though the activity type on the
record has association to one or
more emission types.

For example, the Mobile
Combustion activity type is
associated with emission types
Carbon dioxide and Methane, but
there are no emission records
present in the activity record.

This error can happen in the
following conditions:

« If the calculation mode is
Using matched factors, then
there aren't any emission
factor mappings matching
the attributes on the activity.

- For other calculation modes,
the activity type on the
activity is associated with at
least one emission type and
no emission line has been
entered.

No measures are entered for the
activity even though the activity
type on the record is associated

with one or more measure types.

For example, the Mobile
Combustion activity type is
associated with a measure type
“Quantity.”

Emission records are present in an
activity, but no emission quantity
was calculated. This can happen
when there's no UOM conversion
set up to convert between the
measure UOM and the emission
factor denominator’'s UOM.

Applicable to Calculation Modes

All calculation modes

- Using matched factors

- Manual entry of factors

Manual entry of factors

Chapter 8
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Resolution

matched to the activity for the
emission type.

o For other calculation modes,
ensure that there's only one
emission line entered for an
emission type.

- If the calculation mode is
Using matched factors, then:

o Check that there are matching
emission factors based on
the activity type, activity
type attributes, legal entity,
country, or these fields are
NULL on the emission factor
for a wildcard match.

o The activity date must be
between the emission factor
mapping start and end dates.

o Check that the measure
you've entered on the activity
matches the measure on the
emission factor mapping.

o Check that the measure UOM
matches, or can be converted
to the denominator UOM of
the emission factor

The Oracle Sustainability
calculator always picks the
highest ranked matching
factors on the activity.

- For other calculation modes,
ensure that there is at least
one emission line entered.

Ensure that the activity includes
at least one measure that is
associated with the activity type.

Ensure that there's conversion
factor between the measure UOM
or Currency, and the emission
factor denominator’'s UOM or
Currency.
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Validate Message Validation Details

Missing CO,e UOM conversion CO,e emissions couldn't be

calculated as the emission quantity

UOM couldn't be converted to
the reporting CO,e UOM due
to a missing unit of measure
conversion.

For example, CO2e emissions
couldn't be calculated for the
Carbon Dioxide emission type
because the emission quantity

UOM (gram), couldn't be converted

to the reporting CO2e UOM
(kilogram) as gram to kilogram
conversion is not set up.

Missing reporting UOM The reporting CO2e UOM hasn't

been set up in profile options.

Period is closed Either the activity doesn't have a

period or has one that's closed.

ORACLE

Applicable to Calculation Modes

All calculation modes

All calculation modes

All calculation modes
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Resolution

Ensure that there's a UOM
conversion factor to convert from
the emission quantity UOM to the
CO2e Reporting UOM.

Populate the profile option.

Update the period on the activity to
an open period on the ledger.
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